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Cilem této bakalarské prace je navrhnout a implementovat aplikaci pro podporu
zjistovani poctu osob na fotografii. Metoda rozpoznani poctu osob mutize byt plné
automaticka nebo jen podplirna. Tato prace nejprve uvadi vybér riznych aplikaci
nalezenych prizkumem trhu, které né¢jakym zpisobem zjistuji pocet osob na foto-
grafii. Dale prozkoumava relevantni techniky a metody pro zpracovani digitalniho
obrazu. Prace pokracuje grafickym navrhem aplikace, popisem pouzitych kniho-
ven a vysvétlenim konkrétni implementace aplikace. Nakonec je popsany proces
testovani a co vysledky z tohoto testovani znamenaji.

The goal of this bachelor’s is to design and implement support aplication for coun-
ting crowds of people in photos. The recognition method for counting people can be
fully automatic or just supportive. Firstly selection of different aplications that count
people in photos found with market research is presented in this work. Next it ex-
plores relevant techniques and methods for digital image processing. This work con-
tinues with showing graphical design, description of used libraries and explanation
of specific implementation details of the application. Lastly the testing process is
described and the results of said testing are explained.

image processing « pocitani osob « gui « opencv « javafx
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Uvod

Znalost poctu pritomnych osob na urcité akci nebo shroméazdéni je prekvapive
dutlezita informace. Tato informace se hodi organizatorim nebo treba policii pri
planovani a regulovani budoucich akci [KMH22]. Bohuzel zjisténi poc¢tu osob na
akcich a shromazdénich s volnym pristupem je slozita zalezitost. Pocitani osob v
realném case je nepraktické a naro¢né na prostredky, nebo v nékterych pripadech
i nemozné. Pouziti aplikace, ktera by dokazala odhadnout pocet osob v dané fo-
tografii by velmi pomohlo s timto problémem. Nésledny pristup neni naro¢ny na
prostiedky. Analyzu poctu osob lze provézt z porizené fotografie (napt.: shromaz-
déni, akci, koncertt, demonstraci apod.).

Cilem této prace je vytvoreni aplikace, ktera takto dokaze samostatné nebo s pomoci
uzivatele spocitat pocet osob, které se vyskytuji na dané fotografii. Zptsob spocitani
osob muze byt automaticky nebo poloautomaticky. Poloautomaticky zptisob by mél
byt schopny uzivateli asistovat s manualnim vybiranim osob pomoci intuitivniho
uzivatelského rozhrani, ozna¢ovanim vybranych osob nebo udrzovanim poctu osob.
Automaticky zptisob by mél byt schopny priblizné spocitat pocet osob na dané fo-
tografii bez vétsiho zdsahu uzivatele, pomoci rtiznych technik zpracovani obrazu.

V kapitole 2 miizeme vidét provedeni prizkumu trhu. Tato ¢ast je dulezita z divodu
zjisténi dostupnych aplikaci souvisejicich s pripadem pocitani osob na fotografii.
Prizkum trhu by mohl odhalit zadouci i nezadouci vlastnosti aplikace, stejn¢ jako
dostupnost aplikaci, které by sly pro tento ucel pouzit.

V dalsi kapitole 3 prozkoumame relevantni techniky a metody zpracovani obrazu,
které by bylo mozné pouzit pro stanoveni poctu osob na fotografii. V této kapitole si
projdeme obecné pristupy tradi¢nich metod pro pocitani osob na fotografii, principy
umélych neuronovych siti, a nakonec si predstavime nékteré konkrétni metody.



1 Uvod

V kapitole 4 si popiseme metodu pro automatické pocitani osob na fotografii. Popi-
Seme si postup, ktery tato metoda pouziva k detekci osob, pouzité parametry a jak
zpracujeme vystup této metody.

V kapitole 5 si vytvorime navrh automatické nebo poloautomatické metody pro
zjisténi pocet osob na obraze v digitalnim formatu. Vybér relevantnich technik a
korektni navrzeni metod pro pocitani osob bude mit velky dopad na efektivitu a
presnost vysledné aplikace. Nasledné si popiseme implementaci této navrzené me-
tody v libovolném programovacim jazyce a vhodného odpovidajiciho grafického
uzivatelského rozhrani. Spravna implementace uzivatelského rozhrani bude dile-
zita pro intuitivnost aplikace.

V kapitole 6 radné otestujeme realizovanou aplikaci a popiSeme si postup testo-
vani. Daéle si vyli¢ime, jak byli vybrani testeri a jak byla sestavena testovaci sada.
Nakonec zhodnotime dosazené vysledky.

V zavérecné kapitole 7 si zrekapitulujeme vysledek implementované aplikace a pro-
vedeného prizkumu trhu. Zhodnotime vysledky testovani a co naznacuji. Nakonec
si popiSeme pripadna rozsireni aplikace.



Pruzkum trhu

Tato kapitola prochazi rizné pocitacové a mobilni aplikace a jejich vlastnosti, které
né¢jakym zplisobem zjistuji pocet osob. Vétsina dostupnych aplikaci neni zamérena
na pouhé pocitani osob, a tudiz jsou zahrnuté i aplikace, které pocitaji rizné objekty,
véetné osob. Mezi témito aplikacemi najdeme jak automatické, tak i poloautoma-
tické. Automatické aplikace pocitaji predmeéty samostatné. Poloautomatické aplikace
pomahaji vybirat, pocitat a kategorizovat predmeéty.

Prazkum trhu byl provadén v fijnu 2022, coz znamena zZe popis aplikaci se vztahuje
na verze z tohoto obdobi.

2.1 Priklady aplikaci
211 Counting things

Tato aplikace automaticky detekuje pocet véci podle vybrané sablony. Aplikace je
mobilni, nebo na pocita¢. Demo aplikace obsahuje pét sablon - krizky na bilém
papire, klavesnice, penize, fadky v sesitu, mezi kterymi je i manualni pocitadlo. Pla-
cena verze obsahuje kolem tfi set dal$ich sablon a lze ji zakoupit ve formé licence.
Mezi tyto $ablony patfi materidl z oblasti stavebniho primyslu (napf. instalatérské
trubky, cihly), z oblasti drevarského pramyslu (napt. kmeny strom?, laté, bambus)
dale umi pocitat i zvirata (napt. kravy, ovce, ryby, ptaci), mikroskopické obrazy z
oblasti zdravotnictvi (napf. 1éky, bunky, bakterie), z oblasti zemédélstvi (napt. se-
mena, brouky, vajicka) a dalsi. Zadna z uvedenych $ablon bohuzel nepo¢ita osoby.
Kvli vyssi porizovaci cené licence se aplikace bohuzel nehodi pro soukromé nebo
méné casté uziti. Existuje i verze této aplikace pro pocitani z kamer, coz je ale hlavné
pouzitelné v tovarnach.

Aplikace nabidne moznost Take new photo, po které si uzivatel nasledné vybere
$ablonu. Obrazek Ize vyfotit, nebo nacist z galerie. Po na¢teni obrazku nabidne apli-
kace moznost Count (Pocitej) rozpoznani predméti na fotografii, které potom secte



2.12 iScanner

a nad obrazkem zobrazi pocet. Aplikace umoznuje ulozeni vysledki do excelové
tabulky, do PDF nebo jsou data poslana do n¢jakého back-end systému.

Vyrobce této aplikace je Dynamic Ventures, Inc. Tato aplikace je dostupna na stran-
kich countingthings' pro zatizeni se systémem Windows, Android nebo iOS.

Podobnou funkcionalitu jako aplikace Count Things nabizi i iScanner. Tato mul-
tifunkéni mobilni aplikace je primarné uréend pro skenovani dokumentd je navic
schopna pocitat predméty. Rezim pocitani je ale dostupny pouze v hrazené verzi,
ktera se nabizi opét ve formé licence. Bezplatna verze funkénost pocitani predmeéti
vubec neobsahuje. Tato funkce je nabizena pouze v placené verze a je zaloZzena na
umélé inteligenci. Pres aplikaci vyfotite predméty a ta je automaticky spocita.

Aplikace je vhodna jak pro pouziti napt. pti zjistovani stavu materialu nebo zbozi ve
skladech, nacitani mnozstvi knih v prodejnach apod. Vyrobce aplikace je BPMobile.

Aplikace je dostupna pro Android nebo iOS na webovych strankéach iscanner?.

V této mobilni aplikaci Ize fotit rizné predméty, které pak aplikace automaticky
spocita. Predméty mtize uzivatel sam nafotit nebo si muze vybrat obrazky z galerie
ulozenych fotografii. K vybéru je nékolik rtiznych typt predméti, jako napriklad:
trubky, bedny, ovoce nebo drevéné klady, proto se pouziva predevsim v oblasti pri-
myslové vyroby, stavitelstvi nebo logistiky. Lze detekovat i predméty, které nejsou
ve vybéru, ale presnost potom neni moc vysoka. Diky této vlastnosti Ize detekovat i
osoby, coz je velmi relevantni k nasi dloze. Aplikace je dostupna zdarma nebo v hra-
zené verzi. Pomoci zdarma verze Ize oskenovat a ulozit az 10 fotografii, pri vétsim
poctu fotografii je uz vyzadované zakoupeni plné verze. Placena verze je ve forme
licence.

Vyrobce této aplikace je AIBY Inc. Aplikace je dostupna pro Android ke stazeni
na Google Play obchodé?, nebo pro iOS na App Store*.

Thttps://countthings.com/

’https://iscanner.com/

Shttps://play.google.com/store/apps/details?id=com.countthis.
count.things.counting.template.counter&hl=en&gl=US

“https://apps.apple.com/us/app/count-this-counting-app/
id1553863458


https://countthings.com/
https://iscanner.com/
https://play.google.com/store/apps/details?id=com.countthis.count.things.counting.template.counter&hl=en&gl=US
https://play.google.com/store/apps/details?id=com.countthis.count.things.counting.template.counter&hl=en&gl=US
https://apps.apple.com/us/app/count-this-counting-app/id1553863458
https://apps.apple.com/us/app/count-this-counting-app/id1553863458

2.1.3 CountThis

« Aplikace zac¢ind v hlavnim menu, mdme nékolik moznosti fazeni a organizace
fotografii, coz mizeme vidét na obrazku 2.1(a). Kliknutim na fotoaparat se
aplikace dostane na obrazovku fotoaparatu na obrazku 2.1(b)

« Na obrazovce fotoaparatu na obrazku 2.1(b) mizeme vyfotografovat pred-
méty, které chceme spocitat, nebo si ikonou vlevo dole otevieme galerii foto-
grafii, ze které vybereme snimek.

19min

CountThis

w @

Fit the objects into screen and snap.

=

bl

‘41

2022-12...

Go Unlimited

1/10@Q)

(a) hlavni menu s ulozenymi po¢itanimi (b) Fotoaparat s ikonkou galerie
fotografii

Obrazek 2.1: Obrazovky fotoaparatu a vybirani predmétu



2.1.3 CountThis

+ Vdalsim kroku vybereme objekt ¢i subjekt (v nasem pripadé hlavy osob), ktery
slouzi jako Sablona predmétti, které chceme nasledné vyhledat. Aplikace ndm
poté néjaky predmét navrhne, jak mazeme vidét na obrazku 2.2(a).

+ Aplikace nam vygeneruje body, které jsou podobné nasi sabloné viz Obrazek

2.2(b). Body 1ze manuélné pridavat, mazat a premistovat.

M7 ima 1mM9min QN .

& Count objects & Count objects e ®

Adjust the borders if needed, then tap Count. You can manually add or remove objects.

TR
|_ U

-

" COUNT

(a) Vybirani predmétu pro pocitani (b) Uprava vygenerovanych bodt

Obrazek 2.2: Obrazovky s dpravou bodu a hlavni menu

« Fotografii s prifazenymi body si pak mtizeme ulozit k zobrazeni v hlavnim
menu na Obrazku 2.1(a).



2.14 Object Counter

Dalsi podobna aplikace jako Count this nebo Counting things. Je to mobilni apli-
kace, vyuziva umélé inteligence k pocitani objektti. Téchto typt objektt je v aplikaci
umisténo cca dvacet (napt. drevéné klady, ptaci, lidské postavy, domy na satelitnich
snimcich). Tato aplikace je poskytnuta zdarma. Pouziti aplikace Object Counter je
casoveé naroc¢néjsi z divodu castého umistovani reklam.

Pro pocitani predmétu lze pouzit fotoaparat, nebo vybrat fotku z galerie. Po na-
¢teni fotografie stiskneme tlacitko Count a aplikace pocet predméta spocitd. Ukéze
se obrazovka s oznacenymi predméty a jejich poctem. Aplikace nabidne moznost
ulozeni poctu do historie.

Vyrobce této aplikace je Ocean Float Mobile. Tato aplikace je dostupna na strankach
oceanmobile! pro mobilni zafizeni se systémem Android.

Tato webova aplikace dokaze automaticky pomoci konvoluc¢nich neuronovych siti
odhadnout pocet osob na fotografii nebo na video zdznamu. Vice o konvolu¢nich
neuronovych sitich popisuji v sekci 3.2.4. Aplikace ma velmi jednoduché rozhrani,
ve kterém je umisténé tlacitko pro nahrani fotografie.

Aplikace je dostupna na webovych strankach VCL2.

Aplikace je urc¢ena pro manualni pocitani predmeéti na fotografiich. Rozhrani je in-
tuitivni, dovoluje libovolné vytvareni a upravovani trid predmeétu - rozdéleni pred-
métd do barevné kédovanych skupin (napt. hlavy osob, kachny na fece, spadané
stromy Vv lese atd.). Rozhrani umoznuje snadno vytvaret a upravovat tridy pred-
métd. Pomoci néstrojt pan (tdhnuti mysi pro posunuti priblizeného obrazku) a zoom
(priblizeni obrazku) umoznuje presné pokladat body pro oznaceni individualnich
predmétt. S uvedenou aplikaci Ize exportovat metadata pouzitelna v tabulkach a
softwarech pro zpracovani statistik.

'https://objectcounter.oceanfloatmobile.com/
*https://vcl.iti.gr/crowd-counting/


https://objectcounter.oceanfloatmobile.com/
https://vcl.iti.gr/crowd-counting/

2.1.6 DotDotGoose

Aplikace je dostupna zdarma ke stazeni na webovych strankadch muzea historie -
American Museum of Natural History'. Aplikace je také open source (aplikace s volné
dostupnym zdrojovym kédem), zdrojovy kéd je zdarma ke stazeni na github?.

+ Aplikace DotDotGoose obsahuje ¢tyri sekce uzivatelského rozhrani, coz vi-
dime na obrazku 2.3. V hlavni ¢asti je umisténa fotografie, na kterou se kladou
body. V dalsi ¢asti jsou umistény tridy predméta vlevo nahore, pod kterou
je umisténa cést se souhrnem predméti a moznostmi exportu. V pravé ¢asti
obrazovky je umisténa ¢ést, ktera umoznuje popsani obrazku metadaty a po-
znamkami.

« Fotografii mizeme nahrat bud pretazenim do okna, nebo vybérem pracovni
slozky, ze které se nahraji v§echny obrazky.
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Obrazek 2.3: Okno aplikace DotDotGoose

+ Tahnutim mysi s drzenim levého tlacitka Ize fotografii posunout, otacenim
kolecka na mysi nebo pouzitim tlacitek s lupou ji lze priblizit.

Thttps://www.amnh.org/research/center-for-biodiversity-conservation/
capacity-development/biodiversity-informatics/
software-counting-images-open-source

’https://github.com/persts/DotDotGoose
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2.1.6 DotDotGoose

+ Na obrazku 2.4 mizeme vidét seznam vytvorenych trid predméti (obliceje,
vlajky a dalsi) kliknutim na add tlacitko v horni levé ¢asti obrazovky, u jed-
notlivych tfid 1ze nasledné ménit barvu oznaceni.

Classes

Class
obliceje

viajly B

Delete Add
i [+

Obrazek 2.4: Okno s tridami predméta

« Aktivni tfidu vybereme kliknutim levého tlacitka mysi na nazev této tridy.
Vsechny pridané body budou patrit vybrané tridé.
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2.1.6 DotDotGoose

+ Bod priddme do obrazku drzenim klavesy Ctrl a kliknutim levého tlacitka
mysi na predmét, ktery chceme oznacit jako na obrazku 2.5.

+ Podrzenim klavesy Shift a tazenim mys$i mizeme body oznacit, stisknutim
klavesy Delete, pak mtizeme oznacené body vymazat.

et

Obrazek 2.5: Oznacovani predmétt pomoci boda

12



2.1.6 DotDotGoose

+ V okné na obrazku 2.6 mizeme vidét vsechny tridy, které jsme v predchozich
krocich vytvorili.

+ Pod oknem se souhrnem trid objektt jsou zobrazena tlacitka pro export, na-
¢teni a ulozeni vybranych bodt nebo pocti predmétti.

Summary
Image Count
* demonstrace.jpg
obliggje 3
vlajky 18
Point Radius Display

Grid Size Display
E Load H Save
d' Impart c Reset

(® Counts () Points () Chips ﬁ Export

Obrazek 2.6: Souhrn predméti a moznosti exportu
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2.1.7 Pocitdni objektii v obrazu aplikace Photoshop

Photoshop je program pro Gpravu bitmapové grafiky s velkym mnozstvim nastroju.
Jeden z téchto nastroji ndm umoznuje manualni pocitani polozek na fotografii. Tato
funkce je uzitecna, ale uzivatel musi byt zkuseny v praci s aplikaci Photoshop, aby ji
mohl efektivné vyuzit.

Pro manualni pocitani polozek v obrazu musi uzivatel vybrat nastroj Pocitdni. Dale
muze uzivatel upravit volby tohoto nastroje, mezi které patfi: skupina pocitani,
barva, velikost znacky a velikost popisu. Mize se vytvorit vice skupin pocitani, kde
ke kazdé skupiné Ize nastavit barvu, velikost znac¢ky a popisu. Uzivatel mize vy-
tvorit a zménit skupiny pocitani. Pri drzeni klavesy Alt a kliknutim na znacku ji
uzivatel odstrani. Dale 1ze skryt nebo zobrazit ¢isla poc¢tu. Pro znacku nebo popis
prida kliknutim do obrazu. Vysledny soucet polozek 1ze ulozit do souboru.

V aplikaci Photoshop je k dispozici také automatické pocitani, které se provadi po-
moci nastroje Kouzelnd hulka. Vytvorime vybér, ve kterém jsou zahrnuty objekty
v obraze, které budeme pocitat. Tento nastroj funguje na principu kontrastu barev,
je doporucen kontrast s pozadim pro dosazeni co nejlepsich vysledku. Pri zvoleni
Vybrat datové body v zalozce Analyza z vybéru vytvorime datovy bod pocitani.

Vyrobcem tohoto programu je Adobe. Program je dostupny na webové strance
Adobe! pro systémy Windows a macOS. Instrukce pro pouzivani nastrojii pro poci-
tani jsou téz uvedeny na strankach Adobe?.

Thttps://www.adobe.com/products/photoshop.html
’https://helpx.adobe.com/cz/photoshop/using/
counting-objects-image.html
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2.2 Vyicet viastnosti

Vlastnosti programi jsou zkompilované do nasledujici tabulky 2.1, kde sloupce re-
prezentuji jméno aplikace a radky reprezentuji konkrétni vlastnosti. Tyto uvedené
udaje byly porizeny v fijnu 2022.

Counting things iScanner Object Counter | CountThis | VCL Crowd counting | DotDotGoose | Photoshop

funkénost zdarma verze 5 sablon nedostupno | plna funkénost | 10 fotografii plné funkénost plnd funkénost | nedostupno

cena prémiové verze 2800K¢/mésic | 250K¢/mésic — 109K¢/tyden — — 460K¢/mésic
pocitani z fotografie ano ne ano ano ano ano ano
pocitani z fotoaparatu ano ano ano ano ne ne ne
manuélni pocitani ano ano ne ano ne ano ano

automatické pocitani ano ano ano ano ano ne omezené

open source ne ne ne ne ne ano ne

Tabulka 2.1: vycet vlastnosti jednotlivych aplikaci

Funkcnost zdarma verze udava konkrétni limitace aplikaci ve zdarma verzi. Cena pré-
miové verze popisuje cenu uvedenou pro ziskani licence umoznujici pristup k plné
verzi programu. Pocitdni z fotografie oznacuje moznost nahrani obrazku do aplikace,
ve které pak aplikace pocita predméty. Pocitdni z fotoapardtu uvadi moznost vyfo-
ceni obrazku primo v aplikaci. Manudlni pocitdni vyjadiuje moznost manualniho
vybiréni/kategorizace predmétt uzivatelem. Automatické pocitdni popisuje moznost
pocitani vybraného predmeétu aplikaci pomoci algoritmi nebo umélé inteligence.
Open source oznacuje, zda mé aplikace volné dostupny kéd.

Porovnanim nalezenych aplikaci (Counting things, iScanner, Count This, Object
Counter, VCL Crowd counting, DotDotGoose, a nastroj Pocitani objektl programu
Photoshop) miizeme odvodit vlastnosti, které budou dulezité pri navrhu nasi apli-
kace. Jednou z téchto vlastnosti je Ze vysledna aplikace bude open-source, neboli
zdrojové soubory budou volné dostupné. I samotna aplikace bude volné ke stazeni
a zdarma. Na rozdil od vét$iny nalezenych aplikaci by mohla byt aplikace zaméfena
na pocitani osob, tudiz by byla preciznéjsi. Aplikace nebude vyuzivat vypocetniho
vykonu serveru, coz snizi jeji vykon a presnost, ale bude vzdy k dispozici.
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Relevantni techniky a
metody zpracovani
digitalniho obrazu

Pocitani osob na fotografii je problém uzce spjaty s oblasti zpracovani digitalniho
obrazu. V této kapitole si popiseme nékteré techniky a metody, které jsou relevantni
k této oblasti. Nejprve si v sekci 3.1 vysvétlime tradi¢ni metody pouzivané k pocitani
osob v obraze, do nichz spadaji primé (sekce 3.1.1) a neprimé (sekce 3.1.2) metody.
Nasledné si v sekci 3.1.3 popiseme reprezentaci vlastnosti pri pocitani regresi. Sekci
3.2 si popiseme zakladni popis a ptivod umélych neuronovych siti. V sekci 3.2.1 si
popiseme, jak se tyto neuronové sité rozdéluji podle stylu uceni, v sekci 3.2.2 je uve-
neuronové sité Perceptron. Nakonec si v sekci 3.2.4 vysvétlime zaklady konvoluce a
jak by mohla pomoci v nasi problematice.

3.1 Tradicni metody

Tradi¢ni metody pro pocitani osob v davu se daji rozdélit na pfimé nebo neprimé
metody. Primé metody spocivaji v rozpoznani lidskych vlastnosti. Neprimé metody
berou dav jako celek a zkoumaji jeho vlastnosti, které pak mapuji pocet lidi v davu.

311 PFrimé metody

Primé metody pro rozpoznani déle délime na nékolik skupin. Nejziejméjsi rozdéleni
je, zda detekujeme celou postavu osob jako Monolitickd detekce nebo jen ¢asti téla.
Casti téla také mizeme reprezentovat jako elipsy (Porovnavani tvart). Mezi piimé
metody také nalezi detekce s vice senzory a pro videa mizeme pouzit pocitani
shlukovanim.
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3.1.11 Monolitickd detekce

Prvni skupina se zaméruje na rozpoznani obecnych vlastnosti ¢lovéka. Tento pri-
stup je nejvic intuitivni, jeho princip vychazi z ocislovani osob ve scéné detekci
[Loy+13]. Na monolitické detekci je zalozeny bézny systém na detekci chodcti. Ta-
kovy klasifikacni systém se trénuje pomoci trénovacich fotografii s celymi postavami
osob. Natrénovany klasifika¢ni systém postupné oskenuje cely obrazek pro detekci
kandidatt osob. Podle A survey of crowd counting and density estimation based on con-
volutional neural network [Fan+22] metody vyuzivajici pristup detekovani ¢lovéka
jako celku, maji dobré vysledky, pokud jde o mensi skupinu nebo relativné ridky
dav. V pripadé, ze je hustota davu vysokd, vykon vyrazné klesne. Divodem je casté
prekryvani jednotlivych postav na fotografii.

Druhé skupina metod zamérujicich se na tento problém pocita osoby pomoci roz-
poznavani urcitych casti téla, prioritné hlavy a ramena. Samotné oblast hlavy neni
dostacujici kvtli svému tvaru a vzhledu ke spolehlivé detekci osob. Tato metoda diky
svému pristupu detekce jen ¢asti téla tolik netrpi na prekryvani oproti monolitické
detekci.

Prekryvani osob na fotografii je mozné vyresit zaclenénim vice kamer z rtiznych
uhld. Nevyhodou této metody je potreba instalace vice kamer a takové rozlozeni
neni mozné v mnoha pripadech zaridit. Tato metoda ma leps$i presnost a casto je i
rychlejsi [Loy+13].

Zhao tuto metodu definoval v Segmentation and Tracking of Multiple Humans in
Crowded Environments [ZNWO08]. Definuje set ¢asti téla parametrizovanych jako slo-
zenina elips a stochastickym procesem (proces, ktery nahodnou pravdépodobnosti
dobre popisuje rozdéleni) odhadne konfiguraci elips, ktera nejlépe popise fotografii.

Pocitani shlukovanim je zalozené na tom, ze jednotlivé vizualni vlastnosti jsou jed-
notné, diky ¢emuz je 1ze seskupit, aby tvorili prvky, které se pohybuji. Tato metoda
pouziva nizkouroviové vlastnosti, jejichz trajektorie shlukuje pro odhadnuti po-
¢tu osob na scéné. Metoda vyzaduje souvisly pohyb, jinak mtize nastat nepresny
odhad, kdyz jsou osoby v obraze statické. Pocitani shlukovanim funguje, jen kdyz
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3.12 Neprimé metody

mame k dispozici posloupné snimky. Nevyhoda tohoto pristupu je, Ze nefunguje se
statickymi fotografiemi.

3.1.2 Neprimé metody

Nejvétsim problémem u primych metod je prekryvani osob na fotografii. Tento
problém neprimych metod je mozné resit pomoci uc¢eni mapovani z obrazku na
pocet osob ¢i na mapu hustoty. Prvnim krokem je vytazeni nizkourovnovych vlast-
nosti urceni priznakd, poté se pouzitim rtznych regresivnich modela algoritmus
uci mapovat priznaky na pocet lidi v davu.

3.1.21 Pocitani regresi

Modely zalozené na regresi se nezabyvaji prostorovou informaci obrazu. Regresni
model je takovy model, ktery poskytuje funkci, popisujici vztah jednoho ¢i vice
nezéavislych proménnych a vysledné proménné. Pocitani s regresi se vyhyba déleni
jednotlivct a hledani vlastnosti, odhaduje hustotu davu z priznaki a popisu davu
jako celku. Regresni metody jsou schiidné v pripadech, kdy jsou velmi husté davy a
detekce jednotlivych osob je zfejmé omezena. Tento problém je mozné resit mapami
hustoty (density maps), které mohou poukazovat na pretizeni davu. Mapy hustoty
popisuji hustotu osob davu v riznych ¢astech fotografie. Prestoze tento pristup dava
dobry vysledek, metody zalozené na CNN (konvolu¢ni neuronova sit) je dnes z velké
¢asti nahradily [LSF19].

Obrazek 3.1: Variace hustoty davd, vedouci k riznym mapam hustoty [Yua+22]
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313 Reprezentace vlastnosti

Cela dalsi sekce je shrnutim sekce Counting by Regression v Crowd Counting and
Profiling: Methodology and Evaluation [Loy+13].

Pro provedeni regrese musime vytesit, jak reprezentovat vlastnosti davu na fotogra-
fii. Reprezentace vlastnosti se zabyva vyjmutim, vybérem a preménou nizkotrov-
novych vlastnosti na vstup regresni funkece.

Vlastnosti popredi jsou jednou z nejbéznéjsich reprezentaci pro odhad hustoty davu.
Odectem pozadi ziskame segment popredi, ze kterého mizeme odvodit nékolik
vlastnosti napt. celkovou plochu, obvod nebo pocet jednotlivych komponent seg-
mentu (oddélené casti davu). Slozitost tvaru segmentu mizeme zmérit rozdilem
mezi obvodem segmentu a obsahem.

Segmenty odvozené z davii s nizkou hustotou vykazuji hrubé hrany, zatimco seg-
menty s vysokou hustotou vykazuji hladké hrany. Jednim z téchto detektord hran
je Canny [Can86]. Z hran segmentu mtzeme odvodit tyto vlastnosti: celkovy pocet
pixeld hran, histogram orientaci hran segmentu nebo Minowskiho dimenze (frak-
talni dimenze, dimenze pocitani ¢tverci na hrané), ktera pocita kolik prvka slouzi
pro vyplnéni hran.

Textura davii nese silnou informaci o poc¢tu osob na fotografii. Davy s vysokou hus-
totou ukazuji silnéjsi reakci, ukazuji rozdilnou lokalni strukturu s porovnanim s
ridkym davem. Vzhled a tvar hlavy nebo ramen mize byt objeven gradientni mapou
intensity, coz nese hodné informace o hustoté davu.

Mezi gradientni vlastnosti, pouzivané k odhadu hustoty davu, patri: matice spo-
le¢ného vyskytu stupni sedi (GLCM - grey-level co-occurance matrix), lokalni bi-
narni vzor (LBP - local binary pattern), gradientni histogram (HOG - histogram of
gradients) nebo matice spole¢ného vyskytu orientace gradientu (GOCM - gradient
orientation co-occurance matrix)[HL10].

GCLM (Matice spole¢ného vyskytu stupni Sedi) se pouziva v mnoha studiich poci-
tani davu. Pro ziskani GCLM rozdélime obrazek do osmi stupnd sedé a zamasku-

jeme segmentem popredi. Dale odhadneme pravdépodobnost, ze sousedni hodnoty
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3.13.3 Vlastnosti textury

pixeld jsou stejné p(i, j|6). Tato pravdépodobnost se vypocita pro ¢tyfi rizné orien-
tace (0°, 45°,90°, 135°). Z matice spole¢ného vyskytu stupna Sedi mtizeme nasledné
odvodit pro kazdé 6: stejnorodost (hladkost textury), energie (suma hodnot matic
na druhou) a entropie (ndhodnost textury).

LBP (lokalni binarni vzor) je dalsi vlastnosti k popisu hustoty davi. LBP se casto
pouziva k rozpoznavani obliceji a oblicejové mimiky. Operace LBP se ridi podle
definice lokalnich sousedt, coz je polomér a pocet blizkych bodi sousedicich s cilo-
vym bodem (napft. polomér 1 s osmi sousednimi body). Vysledek LBP tvori binarni
kéd. Tento proces probiha po celém obrazku.
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3.2 Umeélé Neuronové sité

Pred tim, nez si ukdazeme konkrétni zpusoby relevantni k rozpoznani lidi v davu,
které pouzivaji umélé neuronové sité, tak si popiseme obecné fungovani a principy
neuronovych siti. Nejbéznéjsi pristup je kombinace nékolika vlastnosti, ze kterych
vytvorime bazi téchto vlastnosti.

Umeéla neuronova sit je vypocetni model pouzivany v oblasti umélé inteligence.
Je zalozeny na biologickém chovani mozku [Her23]. Neuron je tvofeny télem (soma)
a vybézky z néj, které se déli na dva typy: axony (dlouhé) a dendrity (kratké). V téle
neuronu je ulozeno jadro. Neuron prijima informace z ostatnich neurond pomoci
dendritd a odesila informace pomoci axont. Konec téchto vybézka se nazyva syna-
pse. Efektivnost téchto synapsi mize byt ovlivnéna prochazejicimi signaly tak, Ze se
udi z aktivit, kterych jsou soucasti. Tento efekt slouzi jako lidska pamét, vlastnosti
muzeme vidét napodobené u neurontt umélych neuronovych siti.

Kazda neuronova sit je slozena z neuront, které jsou propojeny tak, ze vystup jed-
noho neuronu je vstupem do jednoho ¢i vice dalsich neuront. Neurony jsou spojené
takzvanymi synaptickymi vahami, které se upravuji pri uc¢eni. Neurony jsou zor-
ganizované do vrstev, kde je prvni vrstva vstupni a posledni vystupni, mezi nimi
mohou byt také dalsi skryté vrstvy. Podle konfigurace se neuronova sit v pribéhu
casu vyviji, méni stav svych neuronti a upravuje odpovidajici vahy.

Aby sit vytvarela spravnou odezvu na vstupni signél, musi byt vdhy neuronové tridy
spravné nastavené. Proces nastaveni téchto vah se nazyva uceni. V problematice
umeélych neuronovych siti u¢eni znamena, ze se sit prizptisobuje, aby mohla 1épe
vyresit ulohu. Sit se prizptsobuje tim, Ze se pokousi eliminovat objevené chyby, ¢cimz
se zvysi presnost sité. Umélé neuronové sité se déli podle zptisobu uceni (trénovani
neuronové sité).

Neuronova sit se uc¢i srovnanim aktualniho vystupu s vystupem pozadovanym.
Tento typ potfebuje znalost pozadované odpovédi pro dany vstup [Pri+16]. Neu-
ronovym sitim jsou prirazeny dva sety dat: trénovaci (urc¢eny k uceni neuronové
sité) a testovaci (uréeny k testovani presnosti neuronové sité). Trénovaci data musi
byt spravné oznacena, coz vytvori vztah mezi vlastnostmi trénovaciho prikladu a da-
ného popisku. Algoritmus uceni s u¢itelem analyzuje trénovaci data a odvodi funkci
pouzitelnou k oznaceni novych prikladt. Idedlni algoritmus by spravné rozhodl o
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3.2.1.2 Uceni bez ucitele

tridé popisku neznamych prikladi. Nastavuje synapse tak, aby se snizil rozdil mezi
skute¢nym a pozadovanym vystupem. Provadi se tolik prichodd, dokud rozdil sku-
te¢nych a pozadovanych vystupi spada do urcité odchylky.

V sitich typu uceni s ucitelem je casto pouzivany algoritmus zpétného §ireni chyby.
Je zalozeny na metodé gradientniho sestupu. Vypocita gradient ticelové funkce s
ohledem na vahy sité. [teruje zpétné z posledni vrstvy, aby se vyhnul zbyte¢nému
pocitani.

3.2.1.2 Uceni bez ucitele

Tento typ neuronovych siti se pouziva v pripad¢, pokud nezname pozadovany vy-
stup predem. Modely, které se u¢i bez ucitele, se mohou naucit jednoduché pred-
stavitele vstupnich dat, kterd mohou byt pouzita ke generovani novych a hledani
existujicich dat. Vahy synapsi se nastavuji tak, aby byl vystup sité konzistentni, tj.
aby sit poskytovala stejny vystup pri stejném nebo podobném vstupu. Pokud jsou
dva spojené neurony aktivovany zaroven, tak zvysi vahu spojeni mezi témito dvéma
neurony. Pri uéeni sit pouziva chyby ve svém napodobeném vystupu k tomu, aby se
priblizila k pozadovanému vysledku.

3.2.2 Siteni informaci neuronové sité

Umélé neuronové sité se daji délit podle zplisobti propojeni neuront a druhu akti-
vacnich funkci neurond. Neuronové sité Ize dale délit podle toho, zda se informace
v siti $ifi acyklicky nebo cyklicky.

3.2.2.1 Dopiedné neuronové sité (feedforward neuronové sité)

Informace v téchto neuronovych sitich jdou jen dopredu. Topologie této neuro-
nové sité je tudiz acyklick4, tzn. vazba nikdy nesméruje zpét. Nejjednodussi model
dopredné neuronové sité je treba Perceptron. Jedna se o jednovrstvou sit s dopred-
nym $irenim. Perceptron ma nékolik vstuptt ohodnocenymi vahami, jeden vystup a
aktivacni funkci.

3.2.2.2 Zpétnovazebné neuronové sité (recurrent neuronové sité)

Topologie této sit¢ je cyklick4, tzn. vSechny vazby sméruji dopredu a nékteré mohou
smérovat zpét. Informace se mohou $irit jak do dalsich vrstev, tak do predchozich
nebo dokonce z neuronu do sebe samého. Zpétnovazebné sité pouzivaji vnitini

pamét pro zpracovani posloupnosti vstupt, diky ¢emuz jsou pouzitelné pro tlohy
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3.2.3 Perceptron

napr. rozpoznavani re¢i nebo rukopisu. Zpétnovazebné neuronové sité ukazuji Tu-
ringovskou uplnost, coz znamen4, ze je mozné spustit (s urcitou obtiznosti) libovolny
program s libovolnym vstupem.

Perceptron je jeden z béZn¢ nejpouzivanéjsich modelt umeélych neuronovych siti.
Perceptron se sklada ze vstupnich hodnot, skalarni a aktiva¢ni funkce, ktera gene-
ruje binarni hodnoty (0 nebo 1). Povazuje se za jednovrstvou doprednou sit. Pouziva
aktiva¢ni funkci, kterd mapuje vstup x, ktery nasobi s naucenou hodnotou vahy w a
vygeneruje hodnotu funkce f(x):

f(x) =1pokudws*x+b>0
f(x) = 0jinak

kde w * x je skalarni soucin:
m
Zi:l WiXi

kde m je pocet vstupli do perceptronu a b je bias, prvek, ktery upravi hranici od
pocatku bez jakékoli zavislosti na vstupni hodnot¢.

Existuje také vicevrstvy perceptron, model neuronové sité podobny jednovrstvému,
ktery ma vice skrytych vrstev a informace se v siti $ifi i zpétnovazebné [JMM96].
Tyto vicevrstvé perceptrony mohou vyresit slozitéjsi nelinearni problémy a funguje
dobre s velkymi i malymi daty. Nevyhodou je, Ze vypocet bude casové naro¢néjsi a
slozitéjsi.
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3.2.4 Konvolucni neuronové sité

Cela dalsi sekce cerpa a je shrnutim ¢lanku Understanding of a convolutional neural
network [AMA22].

Konvolu¢ni neuronové sité (zkratkové CNN - convolutional neural network) maji
vyborny vykon obzvlasté v problémech, které se zabyvaji zpracovanim obrazu. CNN
pouzivaji matematickou operaci nazyvajici se konvoluce (linearni operace mezi mati-
cemi). CNN jsou upravené vicevrstvé perceptrony. CNN maji nékolik vrstev: konvo-
lu¢ni (convolutional) vrstva, nelinearni (non-linearity) vrstva, sdruzovaci (pooling)
vrstva a plné pripojena (fully connected) vrstva. Konvoluéni a plné pripojena vrstva
maji parametry, zatimco nelinedrni a sdruzovaci vrstva nemaji parametry.

CNN jsou pouzitelné v problémech jako napriklad: rozpoznéni videa a obrazu, kla-
sifikace a segmentace obrazu, zpracovani jazyka nebo analyza obrazu z 1ékarského
obrazu. CNN by nemél mit vlastnosti, které jsou zavislé na prostoru. Napriklad by
mél rozpoznavat obliceje bez ohledu na to, kde a jak jsou na fotografii umistény viz
obrazek 3.2.

CNN jsou vhodné k nasi problematice z diivodu, Ze mize presné modelovat ne-
primy vztah mezi fotografiemi davu a po¢tem osob v ném [Kon+23]. Bohuzel pro-
blémy, jako rizna méritka nebo rusné pozadi (nejednotné pozadi fotografie, které
se nesnadné zpracovéava), jsou ale i pres to pro CNN obtizné [Pri+16].
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3.2.4.1 Konvoluce (Convolution)

..f’f\.""’
Iw ANNS= YT e™

Obrazek 3.2: Naucené vlastnosti konvoluéni neuronové sité [AMA22]

CNN se sklada z nékolika prvki:

3.24.1 Konvoluce (Convolution)

Pokud bychom pripojovali kazdou informaci fotografie, bylo by tfeba pouzit prilis
velkého mnozstvi vazenych spojeni. Tudiz pouzijeme mnohem efektivnéjsi metodu,
ve které misto celého obrazu spojime neutrony jen s ¢astmi obrazovky, jak mizeme
vidét na obrazku 3.3. Parametry této vrstvy jsou naucitelné filtry, které maji malou
plochu. Tento zpusob drasticky snizi pocet spojeni a umozni detekovat vlastnosti
bez ohledu na jejich presnou lokaci ve fotografii.
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Obrézek 3.3: Konvoluce jako alternativa pro tplné pfipojenou sit [AMA22]
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3.2.4.2 Krok (Stride)

3.24.2 Krok (Stride)

Pomoci kroku mizeme zménit prekryti neuronu dal$imi vrstvami se svymi sousedy.
Pri zvyseni kroku dale snizime pocet vystupnich spojeni. Na obrazku 3.4 mtizeme
vidét, jak se filtr hybe o 1 pixel s pouzitim kroku 1.

Obrazek 3.4: Filtr se hybe jen o jeden pixel, pro krok 1. [AMA22]

3.2.4.3 Vyplnéni (Padding)

Jedna z nevyhod konvoluce je, Ze dochazi ke ztraté informace na okraji obrazku,
ktera je zptisobena filtrem. Jednoduchym a efektivnim feSenim je vyplnéni okraje
nulami (zero-padding) - pixely s nulovou hodnotou.

26



Navrh

Tato kapitola popisuje navrh metody pro detekci osob na fotografii.

Pro detekci osob na fotografii mizeme vyuzit knihovny OpenCV!. Vyuzijeme pied-
trénovany HOG (histogram orientovanych gradientd) a linearni SVM (metoda pod-
purnych vektor) model.

Metoda pouziva posuvné okénko, ve kterém pri kazdém kroku vytahne HOG vlast-
nosti, které pak posle do linearntho SVM pro klasifikaci.

Pred pouzitim samotné metody zmensime velikost fotografie. Zmensenim fotogra-
fie zajistuje ze musi byt porovnano méné posuvnych okének. Dale zmenseni zvysuje
presnost detekce a snizeni detekce falesnych pozitiv.

Algoritmus ma nékolik parametr(, které jsou velmi dilezité a maji vliv na presnost
a rychlost detekce. Tyto parametry jsou: winStride a padding. winStride je parametr
popisujici velikost kroku posuvného okénka. Cim mensi je tento parametr tim vice
okének musi byt zhodnoceno, coz velmi snizuje rychlost detekce.

Dalsi dtlezity parametr je padding. Tento parametr indikuje pocet pixeli které jsou
vyplnény u posuvného okénka. Pridani trochu vyplnéni pred vytazeni vlastnosti
HOG zvétsuje presnost detektoru.

Po vyuziti automatické metody dostaneme souradnice detekci lidi, které predame
do aplikace pro manualni upravy uzivateli.

Thttps://opencv.org/
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Implementace

V této kapitole jsou popsané knihovny pouzité pri implementaci aplikace. Déle je
popsand adresarova struktura projektu a popis, v jakém prostredi byl projekt posta-
ven. Nasledné je vysvétlen preklad tohoto projektu. Dale je popsan format souboru,
ktery aplikace exportuje, a nakonec si popiseme konkrétni implementace jednotli-
vych trid.

Tato aplikace byla vytvofena v jazyce Java verze 17 s vyuzitim knihovny JavaFX!,
coz je open source knihovna, ve které se stavi aplikace s uzivatelskym rozhranim.
Uzivatelska rozhrani jsou definovana pomoci FXML, jde o znackovy jazyk zalozeny
na XML.

Pomoci knihovny OpenCV? byla vytvoiena automaticka metoda pro detekci a po-
¢itani lidi na fotografii.

Na obrazku 5.1 je zobrazen navrh hlavniho okna nasi aplikace. V horni ¢asti ob-
razku mtzeme vidét tlacitka pro samotné ovladani aplikace. Nalevo je fotografie, na
kterou budeme moci pokladat body a posouvat fotografii tthnutim mysi. V pravé
¢asti jsou uvedeny informace k nactené fotografii a pocet bodd, které jsme polozili.
Névrh grafického rozhrani byl vytvoren v aplikaci moqups?.

'https://openjfx.io/
’https://moqups.com/
Shttps://opencv.org/
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5.1 Model aplikace

[+ — W} People counter

Loadplclurel Export l Import ISelllngsI About Cr\images\img1 jpg

Number of points:
2

O
O

4] C ) 13 A

Obrazek 5.1: Navrh hlavniho okna

5.1 Model aplikace

Aplikace je navrzend podle MVC (model-view-controller) modelu. MVC je designovy
vzor, ktery rozdéli logiku aplikace do tfi spolu propojenych ¢asti. Model je centralni
cast aplikace, spravuje data, logiku a ovlada aplikaci. Model miize reprezentovat
bud data prenasena mezi View a Controller nebo néjaka jina data souvisejici s logi-
kou. View predstavuje reprezentaci a logiku vsech grafickych prvka, které uzivatel

vidi nebo s nimi ur¢itym zptisobem interaguje (napft. tlacitko, rozeviraci seznam, za-
skrtavaci policko). Controller pracuje jako interface mezi Model a View. Zpracovava
logiku a prichozi pozadavky, upravuje data pomoci Model a komunikuje s View, aby
vykreslil kone¢ny vysledek.

5.2 Struktura projektu

Projekt byl sestaven v prostiedi Maven!. Na obrazku 5.2 mtzeme vidét adresaio-
vou strukturu projektu aplikace. Ve slozce javadoc miizeme otevienim souboru
index.html oteviit javadoc dokumentaci projektu. Ve slozce sr¢/main najdeme dvé
slozky java a resources. Ve slozce java jsou controller tridy a vedlejsi pomocné tiidy.
Slozka resources obsahuje fxml soubory, které definuji view z MVC modelu. Ve slozce
tools je umistén nastroj Warp?. Tento nastroj slouzi k vytvoteni sobésta¢né binrni
aplikace a je vyuzity pti prekladu programu. pom.xml (Project object model) je sou-
bor, ktery obsahuje informace o projektu a o jeho konfiguraci pro preklad programu.

Thttps://maven.apache.org/
’https://github.com/dgiagio/warp
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5.2 Struktura projektu

hellofx
| javadoc
| _src
Lg,main
| java
| _org.openjfx
AboutController. java
Controller. java
ControllsController. java
DataHandler. java
DetectionSettingsController. java
ExportedDataReader. java
ExportedDatalWriter. java
ExportMenuController. java
FaceRecognition. java
Main. java
Point. java
PointSettingsController. java
Shape. java
. _moduleinfo.java
| __resources
Lg,org.openjfx
about. fxml
controlls. fxml
detectionSettings.fxml
exportMenu. fxml
pointSettings.fxml
window. fxml

| _tools
Lg,warp—packer.exe
. __pom.xml

Obrazek 5.2: Adresarova struktura projektu
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5.3 Preklad

Pro preklad musi byt nainstalovana Java JDK (java development kit) verze 17 (nemusi
obsahovat JavaFX nebo OpenCV, o ten se postara automaticky preklad) a musi byt
nainstalovany Maven. Preklad je proveden automaticky konfiguracnim souborem
pom.xml. V CMD (command-line) zadejte v hlavni slozce projektu hellofx prikaz:

mvn package

Maven pak automaticky do slozky hellofx/target vytvori JLink prostredi s odpovida-
jicim souborem hellofx-1.0-SNAPSHOT.jar a poté Warp vytvori sobésta¢nou binarni
aplikaci PeopleCounter.exe. Pro spusténi této aplikace nejsou potreba zadné zavislé
knihovny.
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5.4 Formadt exportovaného souboru

b4 Format exportovaného souboru

Exportovany soubor se ulozi na vybranou cestu uzivatele ve formatu s koncovkou
txt v ¢istém textu. Soubor se uklada v kédovani UTF-8. Format tohoto souboru
muzeme vidét na obrazku 5.3, kde kazda radka ma par zaznamu ve formatu pro-
ménnd=hodnota. Soubor je rozdélen na tri Casti: general, points a settings.

541 general

Tato ¢ast obsahuje informaci o absolutni cesté k fotografii picture_path, dale celkovy
pocet bodit oznacenych uzivatelem number_of_points a nakonec informaci finished.
Tato proménna ma hodnotu true, pokud bylo dokonceno pocitani osob, nebo false,
pokud chce uzivatel jesté pokracovat. Tyto informace slouzi k importu do programu,
tak jako jednoduchy prehled uzivateli bez nutnosti importu do aplikace.

54.2 points

V této sekci jsou vypsané souradnice vsech polozenych bodt, které jsou oznaceny
jako p s hodnotami nejprve X souradnice bodu, poté Y souradnice bodu. Téchto
zaznami je N podle poétu polozenych bodt. Cast s body neni povinna a pokud
neni oznacené zaskrtavaci pole v ExportMenu, tak se do exportovaného souboru
nezapise.

b4.3 settings

V posledni ¢asti jsou uvedena v§echna nastaveni, ktera jsou k dispozici v pointSettings
menu. Proménna color je barva bodti v hexadecimalni podobg, shape je tvar bodi ze
tridy Shape (napt. kruh, ¢tverec, plus a trojihelnik), size je velikost pridanych bod
(od 1 do 50) a opacity je neprihlednost boda (od 0 do 100 v procentech, pri 0 % jsou
body skryté a pri 100 % jsou body pIné neprihledné).
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--general --

picture_path="CESTA FOTOGRAFIE’
number_of_points="POCET POLOZENYCH BODU’
finished="TRUE nebo FALSE’

--points--

p="X SOURADNICE BODU 1’ ’Y SOURADNICE BODU

1 ’

p="X SOURADNICE BODU 2’ ’Y SOURADNICE BODU 2’

p="X SOURADNICE BODU N’ ’Y SOURADNICE BODU N’

--settings--

color="BARVA BODU V HEXADECIMALNI PODOBE’
shape=’"TVAR BODU’

size="VELIKOST BODU’

opacity="PRUHLEDNOST BODU’

Obrazek 5.3: Format exportovaného souboru

54.3 settings
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5.5 Popis trid

Trida Main nacte scénu hlavniho okna ovladanou tridouController. Je to vstupni bod
do programu.

Controller je trida hlavniho okna, ktera patfi k view window.fxml. Tato tfida se stara
jak o funkénost tlacitek v menu, tak o funk¢nost ovladani samotné manipulace s
fotografii a pokladani bodu. Trida zajistuje obsluhu udélosti - tzn. kliknuti mysi na
fotografii pro polozeni bodu, posunuti kolec¢ka pro priblizeni a oddéleni fotografie
nebo tdhnuti mysi na posunuti fotografie. Déle obstarava nacteni fotografie vybrané
uzivatelem. Pfi nacteni nové fotografie se z plochy odstrani v§echny polozené body
a obnovi se vychozi stav. Tato fotografie miize byt nactena prfimo otevienim fo-
tografie nebo importovana pres vybrany exportovany soubor. V pripadé nacteni
z exportovaného souboru, jsou polozeny souvisejici body na fotografii a nacteno
nastaveni. Navic trida pridava body na fotografii a kontroluje, aby nékteré nepre-
sahovaly jeji okraj. Body vykresluje na fotografii podle nastaveni styld (barva, tvar,
velikost a neprtihlednost). Tyto body jsou grafické, logicky jsou definované tridou
Point. Déle tfida spousti automatickou detekci ve tfidé FaceRecognition, posadi a
spocita detekované osoby.
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5.5.2 Controller

Body se na fotografii pridavaji zpisobem, ktery je popsany na obrazku 5.4. Podokno
ScrollPane ma jako potomky podokna ImageView a AnchorPane. Do ImageView je pti
nacteni pridana fotografie, zatimco do AnchorPane jsou pridavany body pri kliknuti
na ImageView.

ScrollPane

ImageView

AnchorPane

Points

Obrazek 5.4: Rozlozeni panelt levé ¢asti hlavniho okna
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5.5.3 window.fxml

Nakonec trida Controller pridava funkénost odebrani boda (kliknutim levym tlacit-
kem na cilovy bod) a oznaceni posledniho polozeného bodu inverzni barvou pro
odliseni od ostatnich bodd.

5.5.3 window.fxml

window.fxml reprezentuje view hlavniho okna s controller tfidou Controller. Hlavni
okno je tvorené BorderPane panelem, coz je panel, ktery je tvoreny potomky: Center
(vyplnuje prostredek obrazovky, velikost se odvozuje od ostatnich potomki) Left
(zarovnany do leva), Top (zarovnany nahoru), Right (zarovnany do doprava) a Bottom
(zarovnany dolu). V top ¢asti panelu je umistén MenuBar. V této listé jsou tlacitka
pro nacteni nové fotografie export a import dat, nastaveni stylu bodd, ovladani, about
sekci a ukoncovaci tlacitko, které uzavre aplikaci.

V Center je umisténo SplitPane rozdélujici okno na levou ¢ast s fotografii a pravou
se souvisejicimi statistikami. Leva ¢ast je tvorend pomoci ScrollPane pro posouvani
priblizené fotografie a AnchorPane, do kterého jsou pri kliknuti pridany body. Prava
Cast je tvorena Vbox s popisky cesty k nactené fotografii, popisek aktualniho pribli-
zeni fotografie v procentech, pocet polozenych bodt a zda je pocitani osob dokon-
¢eno. Na obrazku 5.5 mizeme vidét snimek hlavniho okna s otevienou vzorovou
fotografii se tfemi polozenymi body.

B | People counter from image - O *

File  Preferences Help

C\Users\Maso\Desktop\yv...
zoom: 90%

Number of points:

3

Obrazek 5.5: Snimek hlavniho okna
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5.5.4 DataHandler

h.5.4 DataHandler

Trida DataHandler zajistuje poskytovani a ukladani dilezitych dat a nastaveni, které
déle poskytuje k disposici jednotlivym controllerim. V této tridé jsou ulozeny na-
sledujici informace: souradnice oznacovacich bodt, nastaveni stylt bod{, cesta k
fotografii a zda bylo po¢itani lidi dokonceno. Tato tfida je vytvorend podle vzoru
Singleton. Singleton trida je trida, které muze existovat jen jedna instance a poskytuje
jednoduchy globalni pristup k této instanci.

h.5.5b Point

Trida Point reprezentuje jeden polozeny bod. Parametry tohoto bodu jsou X a Y sou-
radnice na nactené fotografii. Tato tfida reprezentuje jen logicky bod o vykresleni
tohoto bodu se stara trida Controller.
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5.5.6 PointSettingsController

5.5.6 PointSettingsController

PointSettingsController je tfida okna s nastavenim stylu bodi patrici k view point-
Settings.fxml. Trida se stard o navazani hodnot posuvnika a jejich popiska. Dale
zajistuje funkc¢nost tlacitek Apply (zmény ulozi a zavre okno) a Cancel (zavie okno
bez ulozeni zmén v nastaveni).

5.5.7 pointSettings.fxml

pointSettings.fxml reprezentuje view okna s nastavenim stylu boda s controller tfi-
dou PointSettingsController. Toto okno je tvorené pomoci VBox, ve kterém jsou po-
pisky s riznymi prvky nastaveni. Vbox je panel, ktery své prvky organizuje verti-
kalné pod sebou. Tyto prvky nastavuji velikost, tvar, barvu a prihlednost bodt. Na
obrazku 5.6 mizeme vidét snimek nastaveni polozenych bodu.

B Point style settings O x
Paint color: | Il Red -
Point shape: | CIRCLE -
Point size: ) 5
Point opacity: ) 100%
Cancel Apply

Obrazek 5.6: Snimek okna s nastavenim bodu

5.5.8 Shape

Shape je enum ttida pro mozné tvary bodt. Mezi tyto tvary patfi: kruh (CIRCLE),
¢tverec (SQUARE), plus (PLUS) a trojuhelnik (TRIANGLE).
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5.5.9 ExportMenuController

5.5.9 ExportMenuController

ExportMenuController je tfida okna s exportem dat, pati k view pointSettings.fxml.
Trida zajistuje spravny export dat do vytvoreného souboru tla¢itkem Export pomoci
tridy ExportedDataWriter. Déle pridava funkénost zruseni akce exportu tlacitku Can-
cel (ztusi akci exportovani).

5510 exportMenu.fxml

exportMenu.fxml reprezentuje view okna s exportem stavovych dat s controller tfi-
dou ExportMenuController. V tomto okné je panel VBox, ve kterém najdeme za-
skrtavaci pole pro export bodi, stylu bod, nastaveni a zda bylo oznac¢ovani bodu
dokonceno. Na obrazku 5.7 mtizeme vidét okno s vyse popsanym exportem.

i Export.. O =
Export peints

Export settings

Counting finished

Cancel Export

Obrazek 5.7: Snimek export okna

5.5.11 ExportedDataWriter

Trida ExportedDataWriter provadi napsani dat do souboru pfi jejich exportu. Tento
format je popsany v sekci 5.4.

5.512 ExportedDataReader

Tato trida se stard o nacteni souboru s exportovanymi daty dle daného formatu a o
jejich néasledné ulozeni.
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5.5.13 FaceRecognition

5.513 FaceRecognition

Tato trida popisuje zpracovani a detekci osob ve fotografii. Trida se stara o nacteni
fotografie do OpenCV, zmenseni této fotografie pro zrychleni detekce. Dale obsahuje
nastaveni parametrd potfebnych k samotné detekci. Po detekci se trida stard o zpétné
zvétseni poméru ziskanych souradnic.

5.514 DetectionSettingsController

DetectionSettingsController je trida okna s nastavenim stylu boda pattici k view de-
tectionSettings.fxml. Trida se stara o predani vybranych hodnot metodé pro detekci
osob. Déle zajistuje funkcnost tlacitek Detect (provede detekci osob) a Cancel (zavie
okno bez provedeni detekce).

5.5.15 detectionSettings.fxml

detectionSettings.fxml reprezentuje view okna s nastavenim metody pro detekci osob
s controller tridou PointSettingsController. Toto okno je tvorené pomoci VBox, ve kte-
rém jsou popisky s riznymi prvky nastaveni metody detekce. U obou popiski jsou
uvedeny moznosti s hodnotami parametrti. Na obrazku 5.8 mizeme vidét snimek
nastaveni metody pro detekci osob.

B OpenCV pedestrian detection O *

OpenCV pedestnian detection settings

winStride: | <hcd -

padding: | 8x8 ket

Cancel Detect

Obrazek 5.8: Snimek okna s nastevenim detekce osob

Hh.5.16 ControllsController

ControllsController je tfida okna s vysvétlivkami k ovladani aplikace, patri k view
pointSettings.fxml. Trida pridava funk¢nost uzavrieni okna tlacitkem Close.
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5.5.17 controlls.fxml

5.5.17 controlls.fxml

controlls.fxml reprezentuje view okna s vysvétlivkami ovladacich prvka s controller
tridou ControllsController. Toho okno je sestaveno pomoci Vbox, ve kterém jsou
oddeélené sekce popisujici detailni ovladani vytvorené aplikace. Na obrazku 5.9 mu-
zeme vidét okno s vysvétlivkami jednotlivych ovladacich prvk.

B Application controls O =

To load new picture select File = Load New Picture
and choose the picture to load

While your cursor is on the image:

Left click: place point

Left click on point: remaove point
Right click: pan image
Scroll wheel: zoom in and out

You can change the color, shape, size and opacity of
the points by selecting Preferences > Point Style

You can automatically detect people using OpenCy
by selecting Tools = Automatically detect People

There are 2 parameters:
win5tride - lowering it increases accuracy and
detection time
padding - increasing it increases accuracy and
detection time

To remove all placed points select Tools = Clear all
placed points

To save your progress select File » Export
Check Export points to export placed point
coordinates
Check Export settings to export current point
settings
Check Counting finished to mark if you have finished

placing points

Obrazek 5.9: Snimek okna s vysvétlivkami ovladani

5.5.18 AboutController

AboutController je trida okna s informacemi o aplikaci, patfi k view pointSettings.fxml.
Tato trida také pridava funk¢nost zavieni okna tlacitkem Close.
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5519 about.fxml

5.5.19 about.fxml

Trida about.fxml reprezentuje view okna s informacemi o aplikaci s controller tridou
AboutController. V tomto okné je panel VBox, ve kterém jsou informace o aplikaci
(autor, vedouci projektu, kontakt atd.). Na obrazku 5.10 mtazeme vidét okno s infor-

macemi o aplikaci.

B " About this application O =

This application was created as a part of a bachelors
project in the FAV department in the University of
West Bohemia
Project leader: Doc. Ing. Dalibor Fiala Ph.D.
Student: Maté] Sochorec
Student e-mail: sochorec@students.zou.cz

Close

Obrazek 5.10: Snimek okna s informacemi o aplikaci
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Testovani

V této kapitole je popsano, jak probihal postup testovani, a jak vypadala testovaci
sada s popisem samotnych soubort v testovaci sadé. Dale jsou vysledky testovani se-
staveny do tabulky a grafd, u kterych jsou prozkoumana mozna vysvétleni vysledkda.

6.1 Struktura testovani

Testovaci sada byla zaslana deseti testerim. Tato sada ma adresarovou strukturu,
kterou muzeme vidét na obrazku 6.1.

testovaci_sada
test_foto
L__8 testovacich fotografii
postup_testovani.txt 6.2
PoepleCounter.exe

Obrazek 6.1: Adresarova struktura testové sady

Ve slozce test_foto jsou fotografie, které testeri oznacili. Tyto fotografie jsou sou-
¢asti datasetu popsaného v sekci 6.3. V souboru postup_testovani. txt na obrazku
6.2 je popsany postup, ktery méli testefi nasledovat. PeopleCounter. exe je samotna
aplikace.

Po splnéni instrukci v souboru postup_testovani.txt odeslali zpét testeri expor-
tované soubory obsahujici vsechny dulezité informace.
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6.1 Struktura testovdni

Tento dokument slouzi k popisu postupu testovani
aplikace pro podporu zjistovani poctu osob na fotografii.

postup testovani:

Spustte program PeopleCounter.exe.

Nac¢téte novy obrazek kliknutim na: File > Load new picture.
Vyberte jednu fotografii ze slozky test_foto piibalenou
v testovacim archivu.

Po nac¢teni obrazku oznacte vSechny osoby na fotografii
umisténim bodu na hlavu.

Pifi ukazovani kurzoru na fotografii:
-body se pokladaji levym kliknutim mySi
-levym kliknutim na bod se tento bod vymaZe
-posunuti koleckem nahoru/dolti se fotografie piibliZzi/oddali
-pravym tlac¢itkem se posune fotografie

Tvar/barva/velikost/pruhlednost bodli se da upravit podle
potreby kliknutim na: Preferences > Point style.

Po dokonceni oznacovani exportujte zaznam bodu
kliknutim na: File > Export.

ZaSkrtnéte policko Export Points a Counting finished
a kliknéte na tlac¢itko Export.

Opakujte 2-4 pro vSechny obrazky ve sloZce test_foto

Pokud narazite na néjakou chybu, nebo na néjaky nedostatek/pripominku
k fungovani aplikace, napiste ji zvlast do textového souboru.

Vysledné exportované soubory a mozné pripominky poslete zpét
preferovanym komunika¢nim kanalem.

Obrézek 6.2: Obsah souboru postup_testovani.txt
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6.2 Demografika testerti

Abychom mohli vyzkum kvalitné zrealizovat musime si spravné definovat cilovou
skupinu respondentt. Existuje nékolik zpisobt vybéru: prosty ndhodny vyber (tes-
tefi jsou vybrani ndhodné), systematicky ndhodny vybér (sestaven z vybéru kazdého
n-tého pripadu, napt. kazdého desatého), stratifikovany ndhodny vybér (vytvoreni
uzce zamérené skupiny - straty) a vicestupriovy shlukovy vybér (neni uzce zaméreny,
nevytvareji se straty, ale jen prirozena seskupeni lidi - klastry). Pro nas vyzkum byl
nejvhodnéjsi zptisob vybéru skupiny testert vicestupriovy shlukovy vybér. Tento zpu-

-----

testerq.

V ramci testovani bylo osloveno 10 testerti, z nichz zhruba polovina byla ve vékové
kategorii 20-25 let a druha polovina 45-55 let. Technickéa schopnost téchto testerd je
podobné pestra, pohybuje se od schopnosti primérného I'T studenta po schopnost
bézného uzivatele. Takto riznoroda demografie testert byla vybrana, aby se ové-
rilo, Ze je aplikace intuitivni pro uzivatele technicky zdatného i pro nezkuseného
uzivatele.

Pro testovaci sadu bylo vybrano osm barevnych fotografii z datasetu Crowd in a rally
[Datl7], uvedeny na webové strance Kaggle. Je to obtizny dataset s 3000+ fotogra-
fiemi, ve kterém byly fotografie porizeny pomoci vice nez ¢tyfmi sty dobrovolniky
v letech 2021-2022. Fotografie jsou v HD (high definition - vysoké rozliseni) kvalité
a byly opatfeny mobilnimi telefony v riznych svételnych kondicich. Fotografie byly
porizeny v riznych méstech Indie. Tyto fotografie mizeme vidét na obrazku 6.3.
Fotografie byly vybrany podle nékolika vlastnosti. Jednou z hlavnich vlastnosti je
pocet lidi, kterych je v radu desitek az stovek, coz je idealni pocet pro nasi metodu.
Dalsi vyznamnou vlastnosti je kvalita fotografie, coz umoznuje presné oznaceni
osob.
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6.3 Fotografie testovaci sady

Pri zpracovani fotografii je tfeba vzdy mit na mysli, Ze existuji rizné rezimy nakla-
déani se zaznamy a jejich nasledné posuzovani. Musime pocitat s tim, Ze k porizovani,
dal$imu pouzivani, $ifeni a zvefejnovani fotografii a videi fyzickych osob mtize do-
chazet v rezimu zpracovani osobnich udaji. Pokud je navrzena aplikace vyuzita
vyhradné pro soukromé tcely (na soukromé party, na svatbé apod.) a neni pozdéji
nikde sdilena, neni tfeba se problematikou zpracovani a ochrany osobnich tudajt
zabyvat. Je-li aplikace vyuzita s cilem dalsiho Sifeni a zverejnovani, je tieba se ridit
platnou legislativou. Z vyse uvedenych déivodt byly vybrany fotografie z volné do-
stupného datasetu, aby nedoslo k poruseni narizeni.

Nékteré z vlastnosti fotografii testovaci sady jsou zajimavé, protoze by se mohly uka-
zat ve vysledcich testovani. Na foto7 mtzeme vidét nejvétsi pocet osob (ve stovkach),
kvili kterému mtzeme cekat vétsi variaci mezi vysledky testerd, nez na ostatnich
fotografiich. Dalsi fotografie s vétsi variaci maze byt foto4, coz je fotografie s velkym
poctem lidi, kteri se prekryvaji, tim padem mutize vést k nejasnosti pri oznacovani.
Na druhou stranu na fotografiich foto2 a foto3 jsou pocty osob v desitkach, jsou
od sebe 1épe rozpoznatelné, takze miizeme predpokladat, Ze bude variace vysledki
mensi.
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6.3 Fotografie testovaci sady

(a) fotol (b) foto2

(c) foto3 (d) foto4

(g) foto7 (h) foto8

Obrazek 6.3: Vybrané fotografie pro testovani
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6.4 Vysledek testovdni

Pocet oznacenych lidi z exportovanych soubort testert byl zapsan do tabulky 6.1.
Radky tester a-j oznacuji pocet oznacenych osob pro jednotlivé fotografie. V fadku
aritmeticky priomér mizeme vidét pramérny pocet lidi oznac¢enych na jednotlivych
fotografiich. Smérodatnd odchylka uréuje miru variability. Pro nas pripad mala hod-
nota smeérodatné odchylky znamen4, ze vsechny pocty lidi na fotografiich si jsou
podobné. Vyssi hodnota znamen, ze byly zfejmé velké rozdily v poctech oznace-
nych lidi mezi jednotlivymi testery. Smérodatna odchylka je uré¢ena vztahem:

2(x—x)?

n—1

kde x jsou namérené hodnoty, X je jejich aritmeticky primér a n je pocet méreni.
Variacni koeficient uréuje standardizovany pomér odchylky a praméru, ktery je da-
lezity z dtivodu riznych poctt lidi na fotografiich. Variacni koeficient je urceny
vztahem: %" kde S, je smérodatna odchylka a X je aritmeticky pramér.

fotol | foto2 | foto3 | foto4 | foto5 | foto6 | foto7 | foto8
tester a 51 45 34 47 55 63 162 29
tester b 58 63 38 72 70 82 210 38
tester ¢ 39 68 36 83 71 88 210 39
tester d 60 69 36 80 76 80 214 36
tester e 52 66 36 74 69 74 200 30
tester f 46 58 35 81 69 73 188 29
tester g 43 45 31 59 61 66 154 29
tester h 51 57 31 68 63 59 183 31
tester i 34 64 42 50 47 57 135 33
tester j 49 63 34 69 69 77 198 30
aritmeticky pramér | 483 | 598 | 353 | 683 | 649 | 719 | 1854 | 32,4
smérodatna odchylka | 8,06 8,68 3,23 | 12,63 8,61 | 10,33 | 26,85 | 3,89
variaéni koeficient 0,167 | 0,145 | 0,092 | 0,185 | 0,133 | 0,144 | 0,145 | 0,12

Tabulka 6.1: pocet oznacenych osob na jednotlivych fotografiich testery
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6.4 Vysledek testovdni

Graf 6.4 znazornuje jednotlivé pocty oznacenych osob pro kazdou fotografii zucast-

nénych testert. Dale v grafu 6.5 vidime primérné pocty osob pro kazdou fotografii,
kde chybové tsecky oznacuji smérodatnou odchylku. Oba grafy byly vytvoreny v

aplikaci Microsoft Excel'.

Pocet oznacenych osob jednotlivych fotografii
250

200

15

100
i 1 st
1 0O ot R R i

fotol foto2 foto3 fotod foto5 fotof fora? fotoB

=

pocet oznacenych osob

fotografie z testovaci sady

m3 mb mc pd me of mg mh ml mj

Obrazek 6.4: Pocet oznacenych osob na jednotlivych fotografii

Pramérny pocet oznacenych osob na fotografii
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Obrazek 6.5: Primérny pocet oznacenych osob na fotografii

Graf 6.6 udava varia¢ni koeficient oznaceného poctu osob na fotografiich vsech

testeru.

Thttps://www.microsoft.com/en-us/microsoft-365/excel
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6.4 Vysledek testovdni

variacni koeficient oznaceného poctu osob na

fotografii
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Obrazek 6.6: Varia¢ni koeficient oznaceného poctu osob na fotografii

Z dat muzeme vycist, Ze u vétsiny fotografii byl variacni koeficient kolem 0,14 s nej-
nizsi variaci 0,092 u foto3 a nejvyssi variaci 0,185 u foto4. Rozdily poctli oznacenych
osob na fotografiich riznych testert mohou byt z nékolika dtvodu.

Asi nejzrejméjsim diivodem je pocet osob na fotografii. Vyssi pocet osob si vyza-
duje vétsi trpélivost a diikladnost uzivatele. Prestoze je na foto7 nejvice osob, je
variace 0,145, coz odpovida variaci ostatnich fotografii s podstatné méné vyfoce-
nymi osobami. Uvedeny pripad se da vysvétlit tim, Ze osoby na foto7 jsou od sebe
vzdaleny, a tudiz lehce od sebe rozpoznany a oznaceny uzivatelem. To nés vede k
dalsimu déivodu vyssi variace: hustota davu. Cim je vyssi hustota davu, tim je tézsi
rozpoznat od sebe osoby na fotografii. Tento problém lze vidét na foto4, fotogra-
fii s nejvétsi variaci. Poslednim divodem je kvalita a ostrost fotografie. Foto3 je
fotografie s nejnizsi variaci, coz si mtizeme odvodit dobrou kvalitou této fotografie.
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Vysledkem této prace je pocitacova aplikace pro systém Windows, slouzici k pod-
pore uzivatele pri pocitani osob na fotografii. V aplikaci lze nacist fotografii, ve které
muze uzivatel kliknutim mysi pridavat a odebirat body pro oznaceni osob. Fotogra-
fii Ize manipulovat tdhnutim mysi a priblizenim koleckem mysi. Styl oznacovacich
bodu (barva, tvar, velikost) 1ze v nastaveni upravit. Po dokonceni prace mize uziva-
tel exportovat polozené body a nastaveni stylu bodt. Naopak pro obnoveni prace a
nastaveni jdou tato data importovat.

V ramci této bakalarské prace jsem provedl prizkum trhu aplikaci souvisejicich s
pocitanim osob na fotografii. Dale jsem prosel relevantni techniky a metody zpraco-
vani obrazu. Uspésné jsem implementoval aplikaci, ktera s pomoci uzivatele spocita
osoby na fotografii. Nasledné jsem navrhl a implementoval automatickou metodu
pro pocitani osob na fotografii pouzitim knihovny OpenCV.V zavérecné fazi jsem
aplikaci otestoval ve spolupraci deseti testerti a zhodnotil namérené vysledky.

Vysledky testovani indikuji, Ze pokud jsou fotografie dostate¢n¢ kvalitni a uzivatelé
dostate¢né peclivi a trpélivi, jsou tedy pocty osob konzistentni, a tudiz je aplikace
spolehliva. Podle kvality fotografie miize automatickd metoda urychlit a usnadnit
oznaceni osob pred manudlnim polozenim bodt. Takto Ize pohodIné spocitat pocet
osob na fotografii s desitkami az stovkami osob. Tisice osob je pro tuto metodou uz
nepraktické a zpracovani jen jedné fotografie by bylo velmi casové narocné. Pokud
je kvalita fotografie velmi nizk4 nebo je velmi vysoka hustota davu, jsou vysledky
zkreslené. Aplikace je pouzitelna pro zjisténi priblizného poctu osob napft. pti kon-
certech, sportovnich utkanich ¢i policejnich zasazich na demonstracich nebo vétsich
davovych setkanich. Aplikace nemusi byt pouzivana pouze institucemi, ale také pro
soukromé potreby, napf. pri kontrole poc¢tu pozvanych tcastnika svatby nebo au-
torského cteni.
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Prilohy

Uzivatelska prirucka

Aplikace je urc¢ena pro systém Windows. Pfed spusténim aplikace neni potreba in-
stalace zadnych knihoven. Spusténim souboru PeopleCounter.exe se otevre aplikace.

Uzivatelské rozhrani se déli na tfi hlavni ¢asti: lista nastroja (horni ¢ast), na¢tena
fotografie (leva ¢ast) a panel s informacemi (prava ¢ast). V 1isté nastroju jsou tlacitka
pro nacteni nové fotografie, import a export, vypnuti aplikace, nastaveni styld bod,
informace o aplikaci a ovladani aplikace. V okné s nactenou fotografii mizeme vidét
polozené body s poslednim polozenym bodem oznac¢enym rozdilnou barvou. V pa-
nelu s informacemi mizeme vidét cestu k nactené fotografii, priblizeni v procentech
a pocet polozenych bodi. Popsané ¢asti uzivatelského rozhrani mizeme vidét na
obrazku 7.1.

B People counter from image = O X

File Preferences Help | lista nastroji

cesta k nactené fotografii
C:\Users\Maso\Desktop\yv...

priblizeni v procentech
zoom: 90%

pocet poloZenych boda
MNumber of points:

3

Obrazek 7.1: Casti uzivatelského rozhrani
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7 Zdvér

Pro nacteni nové fotografie kliknéte na File > Load New Picture a vyberte si obra-
zek k nacteni. Nacteni obrazku mizeme vidét na obrazku 7.2.

B " People counter from image - O

[ZIEW Preferences  Help

no picture loaded

Obrazek 7.2: Nacéteni nového obrazku

Kdyz mate kurzor na nactené fotografii:

levé kliknuti - polozte bod na souradnice mysi

levé kliknuti na polozeny bod - odstrante bod, na ktery kliknete
drzeni pravého tlacitka - posunite fotografii

posunuti kolecka - priblizte a oddalte fotografii
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7 Zdvér

Kliknutim na Preferences > Point Style mizete zménit barvu, tvar, velikost a
neprihlednost. Na obrazku 7.3 mizeme vidét ¢ervenou barvu bodu, tvar bodu kruh,
velikost 5 a 100% neprtihlednost.

B | Point style settings O >
Point color: | Il Red -
Point shape: | CIRCLE -
Point size: 5
Paint opacity: 100%
Cancel Apply

Obrazek 7.3: Nastaveni stylu boda

Kliknutim na File > Export se otevie menu pro exportovani. V tomto menu si
muzete vybrat, jestli chcete exportovat polozené body, nastaveni styli bodu a jestli
bylo pocitani dokonceno. Po kliknuti na tla¢itko Export se otevie okno, ve kterém
si vyberete slozku a exportovany soubor ulozite.

8 Export.. O >
Export points

Export settings

Counting finished

Cancel Export

Obrazek 7.4: Export bodi a nastaveni

Kliknutim na File > Import se otevie okno ve kterém vyberte soubor, ktery byl
exportovany z této aplikace.
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7 Zdvér

Kliknutim na Tools > Detect People se otevie okno s nastavenim pro automatic-
kou metodu detekce osob na fotografii. V okné na obrazku 7.5 mizeme vidét dva
parametry. Snizeni parametru winStride dojde ke zvyseni presnosti detekce, ale také
zvyseni ¢asu detekce, zatimco zvyseni parametru padding zptisobi zvyseni presnosti
a zvys$eni casu detekce. Po kliknuti na tlacitko Detect se spusti metoda pro detekci
osob na fotografii. Po Gspésné detekci se zobrazi okno s vysledky a souradnice de-
tekovanych osob se polozi na fotografii.

8| OpenCV pedestrian detection O >

OpenCV pedestnan detection settings

winStride; | 4xd =

padding: | 8x8 =

Cancel Detect

Obrazek 7.5: Nastaveni metody pro automatickou detekci osob na fotografii
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7 Zdvér

Kliknutim na Help > Controls se otevie okno s instrukcemi k ovladani v angli¢ting,
které muzZeme vidét na obrazku 7.6.

B Application controls O *

To load new picture select File > Load Mew Picture
and choose the picture to load

While your cursor is on the image:

Left click: place point

Left click on point: remove point
Right click: pan image
Scroll wheel: zoom in and out

You can change the color, shape, size and opacity of
the points by selecting Preferences > Point Style

You can automatically detect people using OpenCV
by selecting Tools > Automatically detect People

There are 2 parameters:
winStride - lowering it increases accuracy and
detection time
padding - increasing it increases accuracy and
detection time

To remove all placed points select Tools > Clear all
placed points

To save your progress select File > Export
Check Export points to export placed point
coordinates
Check Export settings to export current point
settings
Check Counting finished to mark if you have finished

placing points

Obrazek 7.6: Okno s instrukcemi k ovladani

Kliknutim na Help > About se otevie okno s informacemi o aplikaci, které mizeme
vidét na obrazku 7.7.

8| About this application O >

This application was created as a part of a bachelors
project in the FAV department in the University of
West Bohemia
Project leader: Doc. Ing. Dalibor Fiala Ph.D.
Student: Maté) Sochorec
Student e-mail: sochorec@students.zou.cz

Close

Obrazek 7.7: Okno s informacemi o aplikaci
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CNN - Convolutional neural network - konvolu¢ni neuronova sit.

MVC - Model-view-controller - designovy vzor pro rozdéleni logiky aplikace.
CMD - Command line - prikazova radka.

HOG - Histogram of oriented gradients - histogram orientovanych gradientda.
GLCM - Grey-level co-occurance matrix - matice spolecného vyskytu stupnu sedi.
LBP - Local binary pattern - lokalni binarni vzor.

GOCM - Gradient orientation co-occurance matrix - matice spole¢ného vyskytu
orientace gradientu.

SVM - Support vector machines - metoda podpurnych vektorda.
JDK - Java development kit
UTF-8 - Unicode transformation format - 8-bit

HD - Hight definition - vysoké rozliseni
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